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Overview 

Program Functions 

Each of the 3 installed programs has a unique purpose and function. 

 3ZWorks is the primary program that transforms an input file to  software data 
format that  the 3Z printer uses to grow a model. 

3ZAnalyzer is a program that presents a visual representation of the model 
building process. This allows the operator to analyze all aspects of the model 
creation in a layer by layer format prior to growing the model. 

3ZOrganizer is an automated program that will automatically retrieve model files 
from a specific location and process them in a pre determined manner. 

The typical file processing is shown in Figure 1: File Processing  
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 Figure 1: File Processing 



10 

System Requirements 

3ZWorks requires the following software and hardware: 

• Microsoft Windows XP or Vista or Windows 7.

• A minimum of 1 GB of RAM.

Solidscape recommends at least a P4 class processor, 10GB  free disk space, 
and a screen resolution of 800 x 600 with 256 colors.  Greater performance, 
memory, and disk space would be needed for more complex model geometries. 

Software Installation 

Before installing a new version of 3Z software, any previously installed versions 
should be uninstalled. See Removing 3ZWorks on page 13 for details. Once the 
software is installed, do not move or rename any of the files or directories. 

To install the 3Z software from the 3Z software installation flash drive, insert the 
installation flash drive in the USB port of your computer. The installation program 
may run automatically. You can also double–click on the file. 

<USB drive>\CDMenu.exe to start the program. Follow 
the setup instructions on the screen to install all the 3Z Software and the 
Configuration Database files. 
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 Figure 2: 3Z Software Installation Menu 

The Configuration Database that is on the installation flash drive may not be the 
most recent version available. First consult the README.TXT file on the drive, if 
present.  Then check the Solidscape web site at romanoff.com under Resource 
Center > Product Related > Solidscape Related Documents, to see if a later
version of the Configuration Database is available. If necessary, download and 
install the Configuration Database after installing 3Z Software.  

All documentation is in Adobe® Acrobat ® format. If your system does not 
include the Adobe Acrobat Reader, you need to install it to view and print the 
documentation included on the flash drive.
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Using 3ZWorks 

This section introduces the 3ZWorks program and describes 
instructions for preparing a model for the Solidscape family of 
machines. 

Overview 

3ZWorks by Solidscape®, Inc. is a Windows based program to generate files for 
their pattern making and tool making machines. 3ZWorks has many convenient 
features that make the preparation of files for the Solidscape printers easy and 
efficient. 

With 3ZWorks you can: 

• Import models in either facet or slice format.

• Position parts on the machine build platform.

• Select configurations to specify build parameters such as slice thickness.

• Slice and fill models to produce binary data files for the Solidscape
machines.

• Monitor machines as your parts are building.

3ZWorks comes with a database of extensively tested build configurations that 
optimize performance of the machines. 

Starting 3ZWorks 

To run the 3ZWorks program, select Programs → Solidscape 3ZWorks →
3ZWorks from the Start button. 

Exiting 3ZWorks 

Click on Exit in the File menu to exit 3ZWorks. 
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Removing 3ZWorks 

Use the following steps to uninstall the 3ZWorks software: 

1. Click Start, Settings, and then the Control Panel icon.
The Control Panel window displays.

2. Double click the Add/Remove Programs icon or Program and Features
for Windows 7.

Build Process Overview 

To build a model on the Solidscape machines, first use the 3ZWorks program to 
create a binary data file. This file contains all the data describing how to build the 
model. It defines each drawn vector for each layer of the model for both the build 
and support materials. 

3ZWorks builds the binary file from a facet or slice file created by a CAD system. 
Binary files can have what ever name the user chooses, but must have a file 
extension that matches the machine type they intend to build it on. The machine 
requires a binary file to build the model. 

Following are the basic steps for preparing to build models: 

1. Load models into 3ZWorks.

2. Position the models on the build platform for the best build. Different
factors to consider include the position of critical surfaces or features, the
position of part and part features relative to the cutter, and the amount of
support required. See Positioning Models on page 15 for details.

3. Use the 3ZWorks Wizard or the Printer Interface to help select build
parameters and automatically generate a binary build file. See 3ZWorks
Wizard on page 31 for more information. Alternatively, select a
configuration based on slice thickness, feature sizes, general model
shape, and the build time. Generate a binary file, using the Slice and Fill
operation. See Selecting a Configuration on page 16 and on page 42 for
more details.

4. Use 3ZAnalyzer to check the filled model for irregularities.

5. Move the binary file to the machine for building.
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Basic Usage 

This section discusses the basic steps for using 3ZWorks. 

Importing Model Files 

Model files for 3ZWorks are designed using a CAD or other modeling program, 
or from scanning a physical part. Models are converted to either a facet or slice 
file format in the CAD or modeling program before being imported into 3ZWorks. 
The most popular file format is STL, which is a standard for the rapid prototyping 
industry and is supported by almost all CAD vendors. 3ZWorks supports both 
ASCII and binary STL formats, as well as DXF and Alias OBJ facet files. For 
further information on these file formats see File Formats on page 84. Slice files 
can also be used for building parts. Although slice files are not as flexible as 
facet files because the part orientation and slice thickness cannot be changed, 
the file size can often be smaller than for an STL file. In addition, some CAD 
systems produce more reliable slice files than STL files. 3ZWorks supports the 
SLC slice format as well as HPGL and the 3ZWorks proprietary SLF format.  
Processing slice files is similar to STL files, however the following restrictions 
apply: 

• Slice files can only be rotated about the Z-axis, so that the slices stay
parallel to the build platform.  They can also be scaled in the X and Y
direction, but not in the Z direction which would change the slice
thickness.

• When choosing a configuration, the slice thickness of the configuration
must match the slice thickness in the slice file.

• When building multiple slice files, all must have the same slice thickness.
If the slice files have multiple slice ranges, all the ranges must match

• Slice ranges can be used with slice files only if the file already contains
multiple slice thicknesses. 3ZWorks will automatically set the slice ranges
for these types of files.

• When generating slice files with a program other than 3ZWorks, do not
specify any line width or tool width compensation.  3ZWorks assumes that
the vectors in a slice file define the actual part boundary and automatically
compensates for the width of the line drawn by the machines.

• Geometric volume estimates are not available for slice files.

Multiple facet or slice files can be loaded into 3ZWorks, to build several parts at 
the same time. The overall build time is less for a build containing multiple parts 
than if each part is built separately. Parts of a multi-piece model, such as the top 
and bottom of a mold, can match each other better if they are in the same build.  
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Positioning Models 

Once a model is loaded, it needs to be positioned on the machine’s build plate. 
Models can be moved and rotated in any direction in 3ZWorks. The position and 
orientation of the model affect the build time as well as the quality of the finished 
part.  

The basic rule for positioning models in 3ZWorks is to have the longest length 
parallel to the cutter and centered in that direction (the Y-axis), and to have the 
shortest length in the Z-axis. This minimizes both the distance the cutter travels 
and the number of layers required to build the model, both of which help 
decrease the build time. When building several models, the taller parts should be 
positioned closest to the cutter, and the shortest parts further away. This 
minimizes the cut length for the upper layers, also decreasing the build time. 

The following are other factors to consider when positioning the model on the 
build plate: 

• Support structures  

− Position the model to minimize the amount of support material, to 
optimize build time and to simplify dewaxing. Support material is 
generated under all model overhangs and around the outside of the 
part. 

− When dewaxing a part, the heated support material expands faster 
than the build material and can therefore crack, break or fracture 
the model. Avoid orientations where there will be large solid blocks 
of support material inside the part, especially inside relatively thin 
walls. 

− If possible, models with large areas of support should be positioned 
so that an area of build material is between the support area and 
the cutter, as the model is being built. This helps prevent gumming 
the cutter with support material. 

• Flat surfaces 

− Flat surfaces will have the best surface finish when positioned to 
face upwards, so they are cut smooth by the cutter. 

− Large flat surfaces which face downward might cause the part to 
“curl” or warp if they are positioned parallel to the build plate. The 
recommended position for this type of model is a five-degree angle. 
If the bottom surface is flat, eliminating the platform layer can also 
help, if a smooth bottom surface is not required. 

• Thin walls  

− Vertical thin walls cut better when positioned perpendicular to the 
cutter. 
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− Cylindrical models with very thin walls build best when positioned 
with the axis of the cylinder parallel to the Z-axis, although this can 
take more time in some cases 

• Critical surfaces 

− Upward facing surfaces are generally better than downward facing 
surfaces. 

− For vertical surfaces, the best detail is on the surface facing the 
cutter. 

− Very fine features can be better defined if built in the Z-axis using 
the smallest layer thickness. 

Selecting a Configuration  

3ZWorks comes with a selection of build configurations that optimize the 
performance of the machines. Each configuration is a set of build parameters 
that has been extensively tested by Solidscape in order to build the best part for 
the particular slice thickness and model type in specific materials. The 
configuration selection determines the build speed and surface quality of the 
model. Different configurations are provided for various model types and various 
material types. Multiple configurations can be used in a model, using the Slice 
Ranges feature, to increase the build speed in sections without a lot of detail, but 
still take advantage of smaller slice thicknesses in sections with fine detail.  

For your convenience, Solidscape has provided the 3ZWorks Wizard to guide 
you through selecting a configuration and setting other build parameters.  See 
3ZWorks Wizard on page 31 for more information on using the Wizard. 
Configurations can also be selected directly using the Slice and Fill dialog.  

The following are the configuration selection variables: 

• Machine type. Configurations are available for each machine type, 
optimized for the characteristics of the machine. Choose a configuration 
that matches your machine type and material. Configurations for one 
machine type cannot be used on another. 

• Configuration Style. Configurations are labeled depending on their design. 
Default configurations are suitable for the widest range of parts, and are 
the best all-around choice. Solid configurations can be used when 
stronger parts are needed for post-processing. Rounded Surfaces are 
designed for parts with shallow rounded bottom surfaces. Fast 
configurations can be used to decrease build times, but part quality may 
suffer.  

• Slice thickness 

− Thicker slices build faster. However, quality might be sacrificed 
depending on the model. 
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− Thinner slices produce smoother surfaces. However, the build time 
is increased. The thinnest layers produce minimal stair stepping on 
curved surfaces. 

− Thicker slices can be used for vertical walls, since there will be no 
stair stepping. 

− Small features might require thin slices. Allow at least six slices to 
build a small feature See  Figure 3: Model Stair stepping.  

 

 

              

   Figure 3: Model Stair stepping 

Slicing and Filling 

The slicing and filling operations generate the binary data file for the Solidscape 
machines. Models are built up slice by slice on the machine, so slicing the facet 
file is the first step in this process. This step is not necessary when using slice 
files. Next, a pass is made through the slices to automatically generate the 
support areas. Finally, the lines to build the slices are generated in the fill step. 
This includes calculating the perimeter lines for both the build material and the 
support, and filling the part interior and support areas with grid lines. When the 
operation is finished, a build time estimate is displayed. 

After creating the build file, examine it with 3ZAnalyzer. If there are no problems, 
copy the file to the printer via network or USB to be built. 
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Examining the File with 3ZAnalyzer  

Running 3ZAnalyzer and looking at the model before it is sent to the printer is an 
important step in the build process. The following lists the reasons for looking at 
the file in 3ZAnalyzer: 

• Ensures the sliced model is good and will build properly 

• Shows what is expected in the build 

• Shows things that might hinder a good build or cause a re-slice using a 
different configuration 

3ZWorks Buttons and Commands 

This section describes all the 3ZWorks screens, buttons and commands. These 
commands can be accessed through the pull-down menus or by using the 
buttons on the 3ZWorks screen as shown in Figure 4: 3ZWorks Screen with 
TestDisk.stl Displayed . 

File Commands 

The File commands are located in the File menu and in the Main Toolbar. These 
commands are used to load and append model files, and to save files. 

Loading Models 

 Open Model opens a browse window to select a model file. This can be 
either a facet or a slice file. Multiple files can be selected in the browse window, 
and all the models will be loaded onto the build plate. Files can also be loaded 
by using the Open option in the File menu, selecting the name of a recently 
opened file from the File menu, by dragging and dropping a file into the 3ZWorks 
application window, or by double-clicking on an STL or SLC file. 

The model is displayed in 3ZWorks at the location where it was designed in the 
CAD system. If the Automatically move model to platform origin when load 

file option in the Options dialog is selected, all parts will automatically be placed 
at the platform origin, at the lower left corner of the build plate. The Status Bar at 
the bottom of the screen shows the total number of facets or slices that were 
read into memory, as well as the number of parts. 

When files are loaded they are assumed to be in the current units. If the model is 
too small or too large, the units are probably incorrect. Reset the units as 
described in Setting Units of Models on page 23, and reload the model. Or, use 
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the Inch to MM or MM to Inch commands to convert the model to the current 
units. 

 

Figure 4 shows the  3ZWorks screen with TestDisk.stl displayed.  This file 
is installed with the 3Z software files and is located in the Sample Models  
directory. 

 

Figure 4: 3ZWorks Screen with TestDisk.stl Displayed 

Appending Models 

 Append Model is used to load more than one model into 3ZWorks. In many 
cases, especially when building small parts, it is desirable to include multiple 
models in one build. Use this command if you are building several different 
models at once.  

As models are added, 3ZWorks displays them in different colors. The first model 
is teal, the second is aqua, the third is green, and so forth. When all the models 
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are appended, they will need re-positioning. To select a model, click on it with 
the mouse. A thin dashed line is drawn around the active model. Multiple parts 
can be selected by holding down the Ctrl key while clicking. To select all parts, 
hit Ctrl-A or pick Select All in the Edit menu. Use the edit commands to 
position the selected models, or the Auto Arrange command to automatically 
position all the models. See Figure 5: 2 models loaded on the build plate.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: 2 models loaded on the build plate 

 

Saving Model Files 

 Save As is used to save a facet or slice file. Models can be written in binary 
STL format, DXF format or 3ZWorks SLF slice format. All models currently 
loaded will be written to the file, in their current positions. Once several models 
have been combined into one file, they are treated as one object and cannot be 
moved and rotated individually.  
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Use this function to save models after they have been positioned for building. 
You can also save slices produced from facet files after the slicing and filling 
operation. This can save time if you want to slice and fill a model more than 
once, for example, to try out two different configurations. 

Adjusting the Display 

Setting the Display Mode 

The display mode buttons, located in the View Toolbar, control what type of 
image is displayed. They are useful for files with many facets because they can 
speed up screen redrawing. The display mode can also be set in the View 
menu. 

 The Wireframe button changes the display to a wireframe view, displaying 
the facet edges or slice edges. 

 The Shaded button changes the display to a fully shaded view for facet files. 
It displays the slice edges for a slice file. The shaded view reveals the most 
detail about how a model looks and how it should be positioned. This is the 
default mode. 

 

 The Bounding Box button changes the display to a bounding box view. 
When the model is in bounding box mode the details are hidden and the screen 
redraws more rapidly.  

Setting the View Angle 

Setting the view angle moves the viewpoint around the build platform so you can 
see the model from different directions. 3ZWorks provides standard views such 
as isometric and top views.  

When changing view angles keep the following in mind: 

• When changing the view angle interactively, hiding the detail on the model 
using Bounding Box mode speeds up repainting of the screen. 

• The view of the model is the only thing being changed; the model is not 
being rotated relative to the build platform. 

The following standard views are available in the View Toolbar. Additional views 
are available in the View menu. 

 Iso View changes to an isometric view, looking towards the left rear corner of 
the build platform. This is the default view. 
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 Top View changes to a top view, looking down on the build platform. 

 Front View changes to a front view of the build platform, from the front of the 
machine. 

 Right View changes to a view of the build platform from the right side. 

Zoom 

The five zoom buttons, located in the View Toolbar, vary the view to see the 
model at different levels of magnification.  

 Zoom Extents adjusts the view so the model fills the screen. Use this 
function when the model is off the screen or partially on the screen. The F9 key 
can also be used for zoom extents. 

 Zoom Window zooms into a sub-area of the model. Click the left mouse key 
and drag the cursor across two diagonal points on the drawing area of the 
screen. Release the mouse key after reaching the second diagonal point. The 
screen refreshes with an enlargement of the area selected in the center of the 
screen. 

  Zoom In and Zoom Out adjust the zoom factor in and out. Use Zoom 

Extents to view the entire model. 

 Zoom Platform adjusts the view so that the machine platform fills the 
screen. This view is useful when positioning multiple parts on the build plate. The 
F10 key can also be used for zoom platform. 

Pan 

 Pan moves the viewpoint up and down or from right to left so that different 
parts of the model are displayed. Click on this button, and then click on the view. 
Holding the left mouse button down, drag the view to the desired position. 

Rotate View 

 Rotate View rotates the view interactively as the mouse is dragged back and 
forth and up and down. Click on this button, and then click on the view. Holding 
the left mouse button down, drag the mouse to view different parts of the model. 

Displaying Toolbars 

The display of the Main Toolbar, the View Toolbar and the Status Bar can be 
toggled on and off using the options in the View menu. Toolbars may also be 
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moved to another side of the 3ZWorks window by selecting them along an edge 
and dragging them to the desired position. 

Settings 

The Settings pull-down menu is used to set various program options. 

Setting Units of Models 

The model units are set in the Settings pull-down menu. Select the system of 
units to match the units of the STL or slice file, before reading in the model. The 
units are also used for displaying numeric values in the dialog boxes, such as the 
slice thickness.  

If a model was read in using the wrong units, use the Inch to MM or MM to 

Inch command to scale the model appropriately.   

Setting the Machine Type 

The machine type specifies the machine where the model builds. Select the 
entry in the Settings pull-down menu that matches the type of machine where 
the model will be built.  Once a machine type is selected, only the corresponding 
configurations for that machine type will be displayed at slice time. 

Options Settings 

Select Options in the Settings menu to display the Options dialog, as shown in  
Figure 6: Options Dialog.  

 

 

 

 

 

 

 

 

 

                      Figure 6: Options Dialog                                                                                                                               
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When Automatically move model to platform origin when load file is 
checked, all models will automatically be moved to the platform origin (front left 
corner) when they are loaded into 3ZWorks. If it is not selected, models will be 
loaded at the position where they were created in the CAD program. This option 
is useful for locating parts that are in an unknown location. 

The Default Model Directory sets the default location to use when loading 
model files, and for writing build files. Click the Default Model Directory button 
and select the directory to use.  

Show bounding box during interactive edit specifies whether to display the 
model bounding box or the model geometry during the interactive Move 
command, to increase the display speed. If checked, the model bounding box is 
also displayed during slice range Z plane selection. See Slice Ranges on page 
38 for more information on Z planes. 

Show bounding box during view rotation specifies whether to display the 
model bounding box or the model geometry during the interactive Rotate View 
command, to increase the display speed. 

The number of slices that are displayed for slice files can be adjusted by using 
the Maximum number of slices to display field. Setting the number lower 
speeds up screen redrawing, while setting the number higher shows more detail 
of the model. 

Allow Boolean Processing specifies whether independent shells within an STL 
file (or a group of STL files) will be joined as they are sliced or if they will be 
treated independently.  This option allows a user to bypass the union solids 
operation (joining) in their native CAD system and allow 3ZWorks to perform that 
operation as it slices. 

The check boxes provide some control over how the independent pieces will be 
processed. 

Unions - Enables the joining of two objects into one. 

Self Unions - Rejoins the ends of an object that overlaps itself, creating an 
I inside and an outside object. 

Insertions - Since double solids equate to voids, this function removes a 
solid object found to be inside another solid. 

Multiple - Sorts the inside versus outside contours of two overlapping 
objects with multiple intersections. 

Single point - Ignores intersections of objects that touch, but do not 
overlap. 

Small Feature - This function removes very small features whose inside 
versus outside may be incorrectly detected. 
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Same Vector - Breaks a vector with multiple intersections into smaller 
vectors with one intersection each. 

Wraps - Wraps may occur when very similar shapes are nested together 
and touch an odd number of times. This causes two objects to be 
misinterpreted as one.  

Overlaps - Overlaps occur when multiple copies of an object exist in the 
same space. This can happen if an object is copied and pasted, then not 
moved to a new location. This function removes duplicate objects. 

The Boolean function does have limitations.  Currently, shells that were created 
via "mirroring" of solids do not join robustly due to their exact symmetry.   Other 
problems may occur in models with very similar contours, single point 
intersections, and self overlapping complex shapes that create internal voids. 

Edit Commands 

The Edit pull-down menu contains commands to position models on the build 
platform, to convert between units and to repair normal vectors in STL files.  

Selection Modes 

 Select is the default mode in 3ZWorks. Click on this button and then on a 
part to select it for an edit operation. To select multiple parts, hold down the Ctrl 
key while clicking on each part. To select all parts, use the Select All option in 
the Edit menu, or hit Ctrl-A. Editing commands affect all selected parts. 

 Select Facet is used with the Rotate to Platform operation. Click on this 
button, and then on one of the facets in a part. The facet is highlighted. Selecting 
a facet also selects that part.  

 Select Z Plane is used to select and edit Z planes for defining slice ranges, 
either in the 3ZWorks Wizard or the Slice Ranges dialog. Click on a slice plane 
in the display to select it. Then click again and drag the plane up or down to the 
desired position. 

Moving Models 

When a model is loaded, it might be off of the build platform. Use the Move and 
Rotate options to position the model on the build platform. In addition, the 
Automatically move model to platform origin when load file option in the 
Options dialog can be used to automatically move parts to the platform origin 
when the are loaded. 
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 Move moves a model interactively in the X and Y directions, on the build 
plate. Click on this button and drag the cursor to move the active part, or multiple 
parts. Parts will move on the build platform, but not in the Z direction. For best 
results, use the Top view with this command. 

 Move XYZ moves a model on the build platform. Specify the move distance 
in the dialog box that displays. If the default is used, the model moves to the 
platform origin (0,0,0). Use this position when building multiple copies of the 
same model, as specified in the Build Model dialog. 

The Auto Center option is located at the bottom of the dialog box. Check this 
option to move the model to the left edge of the platform, centered in the Y-
direction. This is the recommended position for building most models.  

 

 

 

 

                              Figure 7 shows the Move Object dialog  box as it appears 
with pre-calculated distances that move the model to the origin of the platform. 
Override any of the X, Y, or Z distances as required. When clicking OK, the 
software adds the Delta X, Delta Y, and Delta Z distance to every vertex of the 
facet file or every point in the slice file, thus moving the model relative to the 
model’s current position. 

Note: 

The Solidscape printers cannot build a model if any of the coordinates are 
negative, or if they are too far beyond the platform maximum dimensions.  

 

 

 

 

 

 

                              Figure 7: Move Object Dialog Box 
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Rotating Models 

 Rotate to Platform rotates the model so that the selected facet is facing 
downwards on the platform. Use Select Facet to first select the facet, which 
enables the Rotate to Platform button. Then click on Rotate to Platform and 
the model will be rotated into position. In some cases, the rotation may result in 
part of the model lying below the platform. If so, then the model is automatically 
moved up so that the lowest point is on the platform and the selected facet is 
parallel to the build plate. 

 Rotate XYZ rotates the model in space relative to the build platform. Click on 
the Rotate XYX button and the Rotate Object dialog box displays. The rotation 
angles are in degrees, counter-clockwise positive.           Figure 8 shows the 
Rotate Object dialog box. 

 

 

 

 

 

 

          Figure 8: Rotate Object Dialog Box 

The rotation direction follows the right hand rule: Point the right-hand thumb in 
the positive direction of the axis and the fingers curl in the positive rotation 
direction. 

Note the following about the rotation angles: 

• The angles are relative to the current position of the model. If a model is 
rotated by 30 degrees, then to rotate the model back again enter -30 
degrees (or use the Undo command). 

• The model is rotated about the center of its bounding box, parallel to the X-
, Y-, or Z-axis. It is recommended that the model be rotated about one 
axis at a time. 

• Slice files can only be rotated about the Z-axis, so that the slices remain 
parallel to the build platform. 

Scaling Models 

 Scale XYZ scales the model to allow for shrinkage factors or to build scale 
models. 
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When clicking on the Scale XYZ button, the Scale Object dialog box displays.              
Figure 9 shows the Scale Object dialog box. Scale Factors are the multipliers by 
which the model is scaled. For example, if a half-scale model is desired, set the 
factors to .5. If the Same scale factor in all dimensions checkbox is selected, 
all the scale factors will be set to the same value automatically. This is the 
default setting. 

 

 

 

 

 

 

 

             Figure 9: Scale Object Dialog Box 

Slice files can only be scaled in X and Y, so that the slice thickness does not 
change. To scale slice files from one unit of measurement to another, use the 
Inch to MM and MM to Inch commands. 

Auto Arrange 

 Auto Arrange arranges multiple parts on the build platform. Parts are 
arranged in rows and columns so that the tallest parts are closest to the cutter, 
each column is centered in the Y direction, and parts are spaced uniformly. Parts 
are not rotated, so they should be oriented before using Auto Arrange. See 
Figure 10: Auto Arrange Dialog Box . 
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          Figure 10: Auto Arrange Dialog Box 

 

 Object spacing specifies the distance between objects in the X direction and the 
Y direction. Platform offset specifies the width of the margin to leave between the 
outside of the parts and the edges of the build area. Offsets do not include any 
support perimeters or extra support cells. 

Offsets are calculated between the rectangular bounding boxes of each part, so 
the actual distance can be larger than specified, depending on the shape and 
orientation of the models. Note that while the Auto Arrange command attempts 
to find a good arrangement, you may want to adjust the positions to optimize the 
build speed. In some situations, The Auto Arrange operation may not be able to 
find a solution and displays an error message. 

Undo 

 Undo reverses the previous edit operation, returning the model to its size 
and position before the operation was performed. All Edit operations can be 
undone except Compute Normals. To undo the Compute Normals operation, 
delete the part and load the file again. Only one operation can be undone. The 
Undo button is disabled when there is no operation to undo. 

Redo 

 Redo reverses the previous undo operation, restoring the previous edit 
operation. Only one operation can be redone. The Redo button is disabled when 
there is no operation to redo. 

Deleting Models 

Delete deletes the selected model from the build platform. A deleted model 
can be restored with the Undo command. 

Converting Units of Models 

The Inch to MM and MM to Inch commands located in the Edit menu change 
the units of a model after it has been loaded. For example, if the model was 
designed in inches and was loaded with the units set to millimeters, use the Inch 

to MM command to convert the inch model to the current millimeter units. If the 
model was designed in millimeters and the units are inches, select MM to Inch 
from the Edit menu.  
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Repairing Normal Vectors 

STL files are composed of triangular facets and normal vectors. Normal vectors 
are vectors that are perpendicular to the surface of the facet, pointing towards 
the outside of the part and away from the solid build material. In some cases, the 
normals in an STL or other facet file are incorrect or corrupted. This can cause 
the part to fill incorrectly. Recalculating the normals can fix these problems in 
some cases.  

Files with bad normal vectors usually exhibit some of the following 
behavior: 

• When displaying the model in shaded mode, nothing displays. When the 
display is toggled to wireframe mode, the model is visible and appears 
correct. In this case, the normal vectors are all set to zero. 

• When shading the model, it appears that the back surfaces are sticking 
through the front surfaces. In this case, some or all of the normals are 
probably reversed. 

• When shading the model, there appear to be some holes or missing 
surfaces. In wireframe mode the surfaces appear normal. In this case, 
some surfaces are positioned the wrong way and have their normals 
reversed. 

The Compute Normals and Flip Normals commands, located in the Edit menu, 
can be used to repair facet normals. 

Note: 

Incorrect facet normals can affect the way a file is sliced and filled. 
They can also indicate that other data in the file is incorrect. If the 
vectors are still incorrect or the model does not fill correctly after 
using these commands, use the CAD program to make the 
corrections and regenerate the STL file. 

Compute Normals recalculates facet unit normal vectors based on the order of 
the facet coordinates. The vertices of the facets are ordered so that their outer 
unit normals follow the right hand rule. This command will recalculate the normal 
vector for each facet, based on this ordering. 

Flip Normals reverses all normals in the model. In some STL files the facets are 
numbered backwards, while in other situations the facets are pointing in the 
reverse direction. In these cases, computing normals gives a reversed normal. 
The Flip Normals command rectifies these situations. 
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3ZWorks Wizard 

 The 3ZWorks Wizard is the easiest way to prepare a build file for a 
Solidscape machine. It guides you through choosing a configuration, setting slice 
ranges and other options, and generating a build file. Answer the questions on 
each page about the type of models you are building, and other requirements 
you may have. Press Next when you are done with a page. You may go back at 
any time and change an answer by pressing Back. If you are unsure about an 
option, use the default selection, or press Help to display help on any page.  

Some advanced options are not available through the Wizard. For these, use the 
Slice Ranges and Fill dialogs. 

Click on the 3ZWorks Wizard icon to display the first page of the Wizard, as 
shown in           Figure 11: 3ZWorks Wizard. Make sure all your models are 
loaded and positioned on the build plate before using the Wizard. If they are, hit 
Next to continue. If not, hit Cancel to exit the Wizard. 

 

 

 

 

 

 

 

                      

          Figure 11: 3ZWorks Wizard 

The next page is for setting slice ranges, as shown in Figure 12: Wizard - Slice 
Ranges Page . Slice ranges can decrease the build time for some parts, by using 
coarser build parameters in areas that don’t have a lot of detail or where surface 
finish is not important. If your part is uniformly detailed, or if you are unsure 
whether to use slice ranges, choose No. If your part divides naturally into 
different vertical areas, choose Yes and enter the number of sections. Click Next 
when you are finished. 
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Figure 12: Wizard - Slice Ranges Page 

If you entered Yes, the Slice Range Boundaries page displays, as shown in 
Figure 13: Wizard - Slice Range Boundaries Page . Otherwise, the Surface 
Finish page is next. 

Slice ranges are numbered from the bottom of the part to the top, in the order in 
which they are built. The start of the first range is always the bottom of the part, 
and the end of the last range is the top of the part. For other ranges, both top 
and bottom can be changed and the adjoining ranges will be updated 
automatically. 

Set the start and stop Z heights for the indicated slice range. Either enter the Z 
value if you know it, or use the view to drag the slice plane display to the correct 
location on the part. To use the view, move the Wizard window to the side, if 
necessary, and click on the border of the Z plane. Then click again to drag the 
plane up or down. The view can be changed, for example to a side view or a 
wireframe display to make it easier to see the part features. After changing the 
view, you may need to reset the cursor by hitting the Select Z Plane icon, as 
described in Selection Modes on page 25. If you have a complex part and the 
display refresh is too slow, set the Show bounding box during interactive edit 
option in the Options dialog to display the part bounding box while the plane is 
being dragged. 
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Figure 13: Wizard - Slice Range Boundaries Page 

The Display All Z Planes button can be used to show all the current slice range 
boundary planes.  

 

 

 

 

 

 

 

 

 

Figure 14: Wizard - Surface Finish Page 
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Press Next when you are finished with setting the Z values. The Wizard will 
guide you through parameter settings for this slice range, then return to the Slice 
Range Boundaries page for each range. 

The Surface Finish page is shown in  

 

 

 

 

Figure 14: Wizard - Surface Finish Page 

     Select the surface finish you require. This determines the slice thickness 
used, which is the major factor in determining the build time. If you are unsure 
what surface finish to use, choose the default, which produces a very good part. 
With experience, you may decide that you need a better surface finish, or you 
may find that you do not need this level of detail and can decrease the build time 
by using a thicker slice. 

If you are using slice ranges, the slice range is listed at the top of the page. The 
surface finish will apply to that slice range only. 

 

 

 

 

 

 

 

 

 

 

 

  

 

                  Figure 15: Wizard - Solid Part Page 
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Depending on the surface finish you selected, you may have the option of 
building a solid part, as shown in Figure 15: Wizard - Solid Part Page . Most 
Solidscape parts are built with a hollow grid in the interior. Solid parts take longer 
to build, but depending on the casting process you use with the final part, you 
may get better results with a solid part. Solid parts can also be easier to polish. If 
you are using slice ranges, the slice range is listed at the top of the page. This 
option applies to that slice range only.  

Depending on the surface finish you selected, you may have the option of 
selecting a faster build as shown in              Figure 16: Wizard - Speed Page .  
Although the build speed is reduced, the quality of the model may suffer. Do not 
choose the faster build speed if the surface finish is important. In addition, do not 
use the faster build speed if your part has any large overhangs (greater than one 
inch squared or four centimeters squared). The support deposited under the 
overhangs may not have enough time to cool, causing the cutter to become 
coated with support material. 

If you are using slice ranges, the slice range is listed at the top of the page. This 
option applies to that slice range only. 

 

             Figure 16: Wizard - Speed Page 

Once you have chosen settings for each slice range, the following pages will 
guide you through further settings for the entire build. The Extra Support Cells 
page, shown in Figure 17: Wizard - Extra Support Cells Page , lets you specify 
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extra support to surround and brace thin, isolated features. This increases the 
build time, but may be needed for some delicate parts.  

 

 

                   

Figure 17: Wizard - Extra Support Cells Page 

 

       

Figure 18: Wizard – Output File Page 
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The Output File page, shown in Figure 18: Wizard – Output File Page , displays 
the default file name for the build file. To change the file name or the location, 
press the Change File Name button and enter your selection. Click Next when 
you are done. 

Figure 19: Wizard - Summary Page  shows the final page in the 3ZWorks 
Wizard. A summary of the options you have chosen is displayed, along with the 
configuration that was selected for you. If you chose to use slice ranges, each 
range is listed. If you wish to change an option, hit the Back button. Use the Print 
button to print a copy of the page. 

When you hit Finish, 3ZWorks will automatically start the slice and fill process. 
This can take several minutes to complete. When it is done, a Time Estimate is 
displayed, as described in Time Estimate on page 47. Use 3ZAnalyzer to display 
the build file before moving it to your machine to build. 

 

                       Figure 19: Wizard - Summary Page 
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Tools 

The Tools commands are used to generate the binary files that are needed to 
build models on the machines and to display a build time estimate.  The dialog 
boxes for these commands are accessed from the Tools menu, or by using the 
buttons located in the Main Toolbar. 

Model Extents 

 Extents displays the Extents dialog box, which shows the maximum and 
minimum values in X, Y and Z for the selected model as it is positioned on the 
build plate, as well as the overall length in each direction and the number of 
facets or slices in the model. The same information is shown for all models 
currently loaded. The extents are useful for positioning models on the build plate. 
They can also help determine if the units have been set correctly. The Extents 
dialog box is shown in Figure 20: Extents Dialog Box.  

                  Figure 20: Extents Dialog Box 

Slice Ranges 

Slice Ranges displays the Slice Ranges dialog box. This command is used to 
specify multiple slice thicknesses for a model. Some models, such as tools, are 
made up of a detailed section that must be built with a small slice thickness and 
a section with very little detail which can be built with a larger slice thickness to 
save time. Slice ranges are used to specify these sections, and the configuration 
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and other options for building each section.  Slice range data may be edited 
multiple times before the model is built. Slice Ranges can also be used to slice a 
portion of a model, by using a single range and adjusting the start and stop 
heights. The Set Slice Ranges dialog box is shown in . 

 

 

Figure 21: Set Slice Ranges Dialog Box. 

 

 

Figure 21: Set Slice Ranges Dialog Box 

Set the number of slice ranges first, and then select which slice range to edit 
from the pull-down menu.  Ranges are numbered in the order they will be built 
with range 1 at the bottom of the model. There is no limit on the number of slice 
ranges that can be specified; however, only two or three slice ranges are needed 
for most models. The lower part of the dialog box displays information on the 
current slice range, including the configuration and the start and stop Z values.  

To specify the slice thickness and other configuration parameters for the current 
range, use the Select Configuration button to bring up the Configuration 
Notebook. The selected configuration parameters will be used for the current 
slice range.  Note that the configuration options are set independently for each 
individual slice range. See Configuration Notebook on page 40 for more 
information on specifying configurations. 

Set the start and stop Z values for the current range by either using the view to 
specify the location on the part, or by typing the values in the appropriate field. 
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The arrow buttons will increment or decrement the Z value by the slice thickness 
for the range. The start Z value is the start height where the first slice will be 
built.  The stop Z value for a range is the height after the last slice is built.  The 
start Z for the range above the current range will automatically be set equal to 
the stop Z of the current range.  A range must contain an integral number of 
slices, and should not contain less than six slices in order for features in the Z-
axis to be built accurately. The Z values are initialized to the model maximum 
and minimum Z values, and cannot be set above or below the model limits.  

To use the view to set the Z values, move the dialog window to the side, if 
necessary, and click on the border of the Z plane. Then click again to drag the 
plane up or down. The view can be changed, for example to a side view or a 
wireframe display, to make it easier to see the part features. After changing the 
view, you may need to reset the cursor by hitting the Select Z Plane icon, as 
described in Selection Modes on page 25. If you have a complex part and the 
display refresh is too slow, set the Show bounding box during interactive edit 
option in the Options dialog to display the part bounding box while the plane is 
being dragged. 

The Display Z Planes button will display all the start and stop Z planes for 
comparison with the model.  These are best seen with the model in the Front or 
Right view, and using Wireframe display mode.  

The Show All Slice Ranges button will display a summary of all the defined slice 
ranges, which may be printed for reference. 

When you are finished defining all the ranges, hit OK to exit and save the 
settings, or Cancel to discard the changes.  3ZWorks will validate the ranges 
and will make adjustments automatically, if necessary. 

Configuration Notebook 

The Configuration Notebook is accessed through the Fill dialog or through the 
Slice Ranges dialog. The Configuration Notebook contains a database of 
settings that determine how a model is built. There are many different 
configurations for a wide variety of models. Figure 22: Configuration Notebook  
shows the Configuration Notebook dialog.  
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Figure 22: Configuration Notebook 

Select a configuration by slice thickness, using the tree display on the left. Or 
select the configuration directly by typing the ID number in the space provided on 
the right. The configuration picture displays an example of how the build is 
generated using this configuration, to assist in the selection. 

Configuration Options 

Some parameters in the configuration can be adjusted for each build. These 
options are available once the configuration is selected in the Fill dialog box.  
The options are listed below. 
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Model Size Presets 

This option is based on generic model size and used to provide a cutting profile 
that will yield best results (least amount of dust, best Z-Axis accuracy, minimal 
cutter gumming, etc.).   Use the pull down menu to select a model size that 
matches what you are building. 

Custom Cutting Options 

If Custom is selected in the Model Size Preset menu, then you can directly 
specify the cutting profile.  You may select the Number of Passes (i.e. the 
number of times the cutter will move over the model in between each layer), the 
Cut Type (whether it cuts moving from left to right, right to left, or both), the use 
of a Clean Up Cycle (an extra pass over the model without moving the z-axis 
table to help remove residual dust), and Fast Cutting (which doubles the attack 
speed of the cutter for use with small models).  The default is 2 passes, Climb 
Cut, and Clean Up Cycle. 

Extra Cooling Time 

This option is available to users who run their machine in warm environments 
that promote cutter gumming.  It increases the set up time between the last 
deposition of material and the start of a cut on each layer.  In warm 
environments, the materials cool more slowly and may require additional set up 
time before they are hard enough to cut.  If you are experiencing gumming 
(material stuck to the cutter blades), then increase cooling time in increments of 
10 seconds until the gumming ceases. 

Prefilter far vectors (Normally Checked) 

Before computing intersections, 3ZWorks Prefilters Far Vectors to increase 
speed and remove features known to cause certain model defects. On rare 
occasions, very small convex sections are inadvertently filtered out. This results 
in a model defect known as bowties. In the model it appears as unexpected 
surface roughness. In 3ZAnalyzer, it is observed as perimeter lines crossing 
each other. It is preferred that such defects be prevented by moving or rotating 
the model slightly. If this does not prevent the problem, uncheck the Prefilter Far 
Vectors checkbox. Be aware that this may cause unfilled model sections and 
should be disabled sparingly.  

Configuration File 

Use this option to choose a configuration data file. The current configuration file 
name is displayed above the button, along with the version number of the file.   If 
you have several machines of differing types, you may have to switch between 
configuration files to support each machine. 
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Filling Models 

 The Fill operation produces a binary file with the slice and vector information 
needed to build the model on a Solidscape machine. When clicking this button, 
the Fill Options dialog box displays as shown in Figure 23: Fill Options Dialog 
Box. This dialog box is used to specify the current configuration and slice 
thickness, and support perimeter options, support fill options, platform options 
and build options. The options in the Fill dialog box are explained below. 

 

 

Figure 23: Fill Options Dialog Box 

Support Perimeter Options 

The Support Perimeter Options control the perimeter lines for the support 
areas. 
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• Perimeter support only where needed specifies that support 
perimeters will be drawn around the model only where necessary, that is, 
only on layers that have support fill. 

•  Perimeter support over entire part is the default option. Support 
perimeters are drawn around the part on every layer. Adding perimeter 
support walls around the entire model can produce a better surface finish, 
by protecting the build material from the cutter. 

Support Fill Options 

The Support Fill Options allow selecting three parameters for the support fill.  

•  The Excess support slider bar adds excess support around the model, 
specified in number of support cells. The default setting adds one 
additional cell of support material around the outer edges of the support 
areas. If support is generated only where needed, the support edges tend 
to sag and chip off while being built so that insufficient support is left. 
Solidscape recommends one extra support cell for this reason. For tall or 
thin models, the one extra cell may also chip off as the model is built so 
they may require two or even three extra cells of support. Add one extra 
cell of support for each three to four inches in the Z direction. 

•  Continue excess support to top of model is used to brace delicate 
features and tall, thin models. The excess support is added to every layer 
to protect the model. This is the default. Extra support cells can also help 
to brace the part. 

•  Eliminate All Support. Use this option only when no overhangs exist on 
the model. This option does not affect the platform support. If the 

Number of platform support layers is also set to zero, no support 
calculations are performed. 

Platform Options 

•  Number of platform support layers sets the number of platform layers 
to build under the model.  

• For ProtoBase foam substrate, the default is to build one platform layer. 
For parts with large flat bottoms, using zero platform layers (building the 
part directly on the ProtoBase foam substrate) can help prevent part curl 
or warping, but will produce a rougher surface finish on the bottom of the 
part. Using multiple platform layers can make it easier to remove the part 
from the foam after it is built, in order to reuse the foam substrate.  Two 
platform layers are recommend for use with InduraBase. 

• Mill off platform layer is another choice to help prevent parts from 
warping when using the 3Z reusable foam. One platform layer is 
deposited, which is then milled off, leaving a small amount of wax in the 
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foam substrate. This produces a good bond between the model and the 
foam substrate, but leaves enough support material in the foam to enable 
the part to be removed. This option will also produce a rougher surface 
finish on the bottom of the part. 

Output File Name Option 

The output file name can be changed from the default setting with the Output 
File Name button in the lower left corner. By default, the file is given the same 
name as the model, but with the appropriate machine type extension. The 
current file name is displayed to the right of the button. 

OK Button 

Select the OK button when finished with all the preceding settings to start the 
slicing and filling process. Selecting Cancel returns to the 3ZWorks screen and 
does not perform slicing and filling.  

If a facet file is loaded, it is sliced before creating the build file. These slices can 
be saved after completing the slicing and filling operation, using the Save As 
function as described in Saving Model Files on page 20. If a slice file is loaded, 
the slice step is omitted. 

While the model is slicing and filling, status information is displayed in the Status 
Bar along the bottom of the screen. Press the ESC key at any time to stop the 
process. When 3ZWorks is finished generating the build file, the time estimate 
will be displayed automatically. 

Expert Button 

The Expert button reveals four checkboxes. These are specially designed to 
eliminate certain, rare occurring problems within a model file. 

Suppress Bowties 

This is a more aggressive filter for reducing ‘bowties’ in models. It deletes vectors 
that are very close but do not numerically intersect. Depending on part geometry, 
it is more likely to delete valid geometry and therefore is more likely to adversely 
affect the model quality. It is recommended that Prefilter far vectors be tried first. 

Reduced Colinear Filtering 

This function disables some of the filtering that joins small, non-printable vectors 
into longer printable vectors. It results in slower models with more accurate 
curves. See Figure 24: Expert Mode.  
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Figure 24: Expert Mode 

Eliminate all support 

This function will cause on build vectors to be generated. No support structure 
will be generated. 

Remove Dead Loops 

Dilation and contraction algorithms can generate inverted loops that need to be 
removed. STL defects increase the likelihood that an undesirable loop remains. 
This switch enhances that algorithm that removes dead loops, but on highly 
faceted models, it may result in dropped support.  
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Time Estimate 

 Time Estimate calculates the build time of a model based on a machine 
type specific binary file. The estimate is computed using the number of 
build and support vectors in the file, their lengths and the velocity at which 
they are drawn. The Build Time Estimate displays automatically after 
filling a model, or at any time by using the Time Estimate command and 
selecting a binary file. If slice ranges were used, the Show All Slice 

Ranges button will display all the slice ranges used in the file, including 
configurations and Z height ranges. The estimate can be printed using the 
Print button at the bottom of the screen.  The estimate also contains the 
amount of material needed to produce the model. See Figure 25: Build 
Time Estimate dialog box.  

 

Figure 25: Build Time Estimate dialog box. 
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Using the Printer Driver 

Overview 

3Z The Printer driver is a graphical interface similar to other windows based 
desktop printer drivers. It provides the user with a quick means to locate a printer 
or other output device, set the printing parameters and then generate a print job 
for the 3Z printer.  The printer driver works within 3ZWorks. See Figure 26: 
Printer Driver.  

 

The printer driver allows the user to: 

• Define and select the destination for the processed file. 

• Determine the status of the printer (Network only). 

• Select the properties for the print job. 

• Send the processed file to the printer or other destination. 

• Process the file to a deferred location for later use. 
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Figure 26: Printer Driver 

File Destination 

The upper half of the dialog box is used to define and check the status of the 3Z 
printer(s) or other destinations such as a Flash Drive. It also controls the 
properties of the defined printer. 

Define a printer as a destination  

There a 3 methods to define a printer as the destination of a model file. The 
printer must be on a local area network  in order to be located and defined.  
The first method is to allow the software to automatically locate (AutoSearch) the 
network address for you. The second is to (Browse) your network to locate the 
printer. The third method is to (Manually) enter the network name of the printer. 
See Figure 27: Find Printer.     
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Figure 27: Find Printer 
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AutoSearch 

To automatically search for a printer, click on the Find printer and then the 
AutoSearch button.  See Figure 28: AutoSearch Window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 28: AutoSearch Window 

The base IP address of your local area network must be defined in order for the 
search to be successful. If you are not sure of your local area network address, 
click on the Match Local Machine  button or contact your system administrator. 

Once the base address is established, click on the Search button and the 
program will automatically search the network for all the 3Zprinters that are 
powered on and active on the network. All responding printers will be listed with 
the network name and serial number. To select a listed printer, simply double 
click on the serial number desired. 
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Browse 

To browse the network, click on the Browse  button.  Locate the desired printer 
on the network and double click on the serial number to access it.  Finally, select 
the jobs folder and click open. See Figure 29: Browse for printer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 29: Browse for printer 

Manual Setup 

To manually select the printer, click on the Manual Setup button. Set the Type to 
3ZPRO and manually type in the network name of the printer. 
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Figure 30: Manual Setup 

Define a Flash Drive as a destination  

Install the flash drive in the host pc and insure that is defined and accessible with 
a drive letter. (E:) for example.  Select the Browse  button. Navigate the PC to 
locate the Flash drive and then click Open.  You may also enter a name for you 
Flash drive in the comment section.  See                  Figure 30: Manual Setup , 
Figure 31: Locate Flash Drive and Figure 32: Flash Drive Named.  

 

 

 

 

 

 

 

 

 

                                    Figure 31: Locate Flash Drive 
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                 Figure 32: Flash Drive Named 

Print to file only 

If this box is checked, the file will be processed and sent to the location of the 
original STL file.  It will not be sent to any other location. This can be used if the 
printer is busy.  See Figure 33: Print to file only. 
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Figure 33: Print to file only 

 

 

Properties 

Clicking on the Properties  button will allow the user to select specific instructions 
to be used during file processing. There are four tabs within the properties dialog 
box.  See Figure 34: Properties dialog box.  
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Figure 34: Properties dialog box 

 

Basic - Refer to page 43 for details. 

Expert - Refer to pages 41 through 46. 

3ZWorks - Refer to page 23 for details. 

Configs - Refer to page 40 for details. 
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Printer Status 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                  
Figure 35: Printer Status 

The status of the current printer or other destination is shown to the right of the 
image. Clicking on the Refresh  button will send a request to the device for 
current settings. Clicking Detailed Status  will display a more detailed status of 
the printer including printhead information. See Figure 35: Printer Status and 
Figure 36: Detailed Status.  
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                              Figure 36: Detailed Status 

 

Printing a Model 

 

The lower portion of the printer interface is used for setting the print resolution, 
accessing 3ZWorks,  and for executing the print job. 

Quality 

The Quality section of the printer driver is used to set the Z axis resolution for the 
print job. See Figure 37: Quality selection and Figure 38: Radio buttons and 
Dynamic slider.  
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                      Figure 37: Quality selection 

 

 

 

 

 

 

 

                  Figure 38: Radio buttons and Dynamic slider 
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The user has a choice of Z resolutions from 0.00635 mm to 0.0762mm in 
.00635mm increments.  The resolutions can be selected via preset radio buttons 
or a dynamic slider. The radio buttons are set as follows: 

 

• Last Used -   The resolution will be set to the same resolution used when 
the last file was processed. 

• Fastest  - The resolution will be set to 0.0762mm, the coarsest available. 

• General purpose - The resolution will be set to 0.04450 mm, a medium 
setting. 

• Best quality  – The resolution will be set to 0.00635 mm, the finest 
available. 

• Custom – This indicates a resolution was selected with the dynamic slider. 

 

The dynamic slider allows an incremental resolution selection from left to right 
with the far left being the finest and the far right being the coarsest.  

The currently selected resolution is displayed above the slider. Refer to  

                 Figure 3: Model Stair stepping   for more information on 
configurations. 

The sphere and clock visually indicate the selected resolution and 
relative time to print a model.  See  

         Figure 39: Visual Resolution and Time indicator. 

 

 

 

  

 

 

 

         Figure 39: Visual Resolution and Time indicator 

The image on the left indicates the finest resolution and the clock indicates the 
maximum time to print. The image on the right indicates the coarsest resolution 
and the minimum time to print. 
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Interacting with 3ZWorks 

There are 2 methods of switching between the printer driver and 3ZWorks. See 
Figure 40: Interacting with 3ZWorks.   The preview button will alternately show 
and hide the 3ZWorks build plate layout and will keep the printer driver dialog 
box active. The 3ZWorks button will close the printer driver dialog box and open 
the 3ZWorks window for full control.  The printer driver must them be reopened 
by clicking the printer driver icon from 3ZWorks . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 40: Interacting with 3ZWorks 
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Show Details 

This button will toggle to alternately Show and hide more detailed 
information regarding the selected printer and the processing 
display. See          

    Figure 41: Printer  Driver Details.    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

         

    Figure 41: Printer Driver Details 
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The details shown include: 

• The Type of printer selected. 

• Where the printer is located (Device Name). 

• Any Comments entered when the device was initially located and defined. 

• The status of the Remote  information. 

• The type of data transfer (Xfer) selected for this device. 

• The Display control allows the selection and display of the time estimator, 
whether to launch 3ZAnalyzer after processing the file, launching the 
remote monitor and whether to hide all windows when processing a file. 

• Detailed configuration information  is displayed below the Quality 
selection. 

 

Click on the Hide Details button to hide the details.  

Printing the File 

To complete the printing process, click on the Print  button. The file will be 
processed. Depending on the display control settings, the file will be sent either 
to 3ZAnalyzer or directly to the destination previously specified.  

If the printer is currently busy, the print button will indicate Deferred Transfer.   
The file will be sent to an individual folder assigned to that printer serial number. 
If 3ZOrganizer is active, the file will automatically be sent to the printer when the 
current job completes. See Figure 42: Printing the file.  
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Figure 42: Printing the file 
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Using 3ZAnalyzer 

Overview 

3ZAnalyzer is a slice viewer designed to view the files generated with 3ZWorks. 
The viewer displays slice cross sections with the fill patterns.  Exact vectors are 
drawn that trace the jet path over the build platform for each slice. Support 
material is shown in red and the build material is shown in green and blue. 

Measurements can be extracted from this file using the digital readout in the 
Status Bar at the bottom of the screen. The units of measurement are in 
thousandths of an inch (mils) or in millimeters. When taking measurements from 
the screen, be aware that the material laid down along the path of the jet has a 
finite thickness that is not shown on the screen. The slice number and the Z 
height of the start of the current slice are also displayed in the Status Bar, in 
inches or millimeters. 

Figure 43: 3ZAnalyzer Screen Layout  shows the general layout of the screen 
with a portion of a slice from the TestDisk.stl model. 
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Figure 43: 3ZAnalyzer Screen Layout 

 

The View and Linetype toolbars are dockable and can be moved to other sides 
of the 3ZAnalyzer window, or optionally not displayed. To toggle the display of 
the toolbars or the Status Bar, use the options in the View menu. 

3ZAnalyzer Buttons and Commands 

This section explains the 3ZAnalyzer commands.  These commands can be 
accessed through the pull-down menus or by using the buttons on the 
3ZAnalyzer screen as shown in Figure 43: 3ZAnalyzer Screen Layout.  

Loading Files 

 Open opens a browse window to select a particular Solidscape binary file.   
The file type corresponds to the machine type for which it was generated.  The 
file is loaded into 3ZAnalyzer for viewing. Files can also be loaded by selecting 
the name of a recently opened file from the File menu, by dragging and dropping 
a file into the 3ZAnalyzer application window, or by double-clicking on a 
Solidscape binary file. 

 Delete deletes the current file from 3ZAnalyzer. It is not necessary to delete 
a file before loading another, unless you wish to reload the same binary file. 

Slice Playback 

The Slice Playback feature dynamically displays all the slices in a file, one after 
the other. This gives a preview of how the part will be built and can be used to 
quickly check for bad slices.  

 Play plays the slices dynamically on the screen starting at the current slice. 

 Stop halts the dynamic slice display. The ESC key can also be used to stop 
the slice display. 

To adjust the playback speed, select Options in the Settings menu. See . 

 

Options on page 70 for more information. 
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If the cursor is hard to see during slice playback, you may need to turn off pointer 
trails. This option is located in the Windows Control Panel, under Mouse, Motion 
options. 

 

Slice Navigation 

Individual slices can be displayed using the slice navigation fields, located in the 
Main Toolbar. 

Use the Slice Location slider to move anywhere in the file. Moving the slider all 
the way to the left will display the first slice, and moving it all the way to the right 
will display the last slice. Clicking the cursor on the slider to the right or left of the 
position pointer will move up or down 10% in the file. You can also use the Page 

Up and Page Down keyboard buttons to move up and down the file. 

To display a particular slice, enter the slice number in the Slice Number field. Or, 
enter a Z value in the Slice Z height box to display the slice closest to that Z 
height. The Z height includes the height of any platform layers. Use the arrow 
buttons to the right of either field to move up or down a slice. You can also use 
the up and down arrow buttons on the keyboard to move up and down, one slice 
at a time. 

Time Estimate 

 Time Estimate displays the time estimate for the current build file.  See Time 
Estimate on page 47 for more information on build time estimates. 

Help 

 Help Topics displays the 3ZAnalyzer on-line help.  Help can also be 
displayed by selecting Help Topics from the Help menu, or by hitting the F1 key. 

To display version and copyright information for 3ZAnalyzer, select About 

3ZAnalyzer from the Help menu. 

Grid Lines 

 The Grid Lines button is used to toggle the display of platform grid lines, 
drawn in black. These lines can help determine the size of foam substrate 
required, and where to position it on the build plate. Grid lines are drawn at one 
inch or one centimeter intervals. 
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Zoom Buttons 

The zoom buttons adjust the portion of the slice visible on the screen, by 
changing the magnification. To view the entire build platform, use Zoom 

Platform. Use Zoom Extents to view the portion of the build platform containing 
the model vectors. 

 Zoom Extents zooms to fit all the build and support vectors for the current 
slice onto the screen. The F9 key can also be used for zoom extents. 

 Zoom Window zooms in on a specific area of a slice. Click the left mouse 
key and drag the cursor across two diagonal points on the drawing area of the 
screen. Release the mouse key after reaching the second diagonal point. The 
screen refreshes with an enlargement of the area selected in the center of the 
screen. 

 Zoom In increases the magnification toward the center of the screen by 25 
percent.  

 Zoom Out decreases the magnification of the part by 25 percent. 

 Zoom Platform adjusts the view so that the machine platform fills the 
screen. The F10 key can also be used for zoom platform. 

Panning 

 Pan moves the viewpoint up and down or from right to left so that different 
parts of the slice are displayed. Click on this button, and then click on the view. 
Holding the left mouse button down, drag the view to the desired position. 

Linetype Display 

The linetype buttons are used to turn the display of the various linetypes on or 
off. The buttons are located in the Linetype Toolbar, or the commands can be 
accessed through the View menu.  

Each linetype is used to build a specific portion of the part, or of the support 
region. Not all linetypes are used for all parts. In particular, no build closeoff 
linetypes are used for solid configurations.  

Perimeter lines define the outer surface of the parts, and echo the part boundary. 
Perimeters are also drawn around the inner edge of the support material, to 
protect the part and to anchor the support fill region. Fill lines define the basic 
grid structure used to build the interior of parts and support. In some 
configurations, a weld perimeter line is used to join the build perimeter to the 
build fill structure. 
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Build closeoff linetypes are used to seal the inner grid structure as the part 
geometry changes from layer to layer, and they form part of the outer surface of 
the part. Both upper and lower surfaces need to be closed off. Similarly, support 
closeoff linetypes are used to build a solid support surface, before build material 
needs to be deposited in that area. Only upper closeoffs are used for support. 

The following buttons turn the display of a particular linetype on and off. 

 Build Perimeter defines the outer boundary of the part. 

 Weld Perimeter is a perimeter drawn in the build material, used to join 
the Build Perimeters to the Build Fill. The Weld Perimeter is displayed in blue in 
3ZAnalyzer. 

 Support Perimeter forms the inner boundary of the support region. It is 
also used to protect the Build Perimeter while the part is being built. 

 Build Fill forms the interior of the part. 

 Support Fill forms the support regions. 

 Build Lower Surface Closeoff 1 is the first pass closeoff for lower 
surfaces of the build material. It is used to form a solid surface under the open 
Build Fill grid, and forms the lower outer surface of the part. Parts built using 
solid configurations do not require build closeoff.  

 Build Lower Surface Closeoff 2 is the second pass closeoff for lower 
surfaces of the build material. It is used to form a solid surface under the open 
Build Fill grid. Parts built using solid configurations do not require build closeoff.  

 Build Upper Surface Closeoff 1is the first pass closeoff for upper 
surfaces of the build material. It is used to form a solid surface on top of the 
open Build Fill grid. Parts built using solid configurations do not require build 
closeoff.  

 Build Upper Surface Closeoff 2 is the second pass closeoff for upper 
surfaces of the build material. It is used to form a solid surface over the open 
Build Fill grid, and forms the upper outer surface of the part. Parts built using 
solid configurations do not require build closeoff.  

 Support Upper Surface Closeoff 1 is the first pass closeoff for upper 
surfaces of the support material. It is used to form a solid surface on top of the 
open Support Fill grid, two layers before build material is built on top of the 
support region.  

 Support Upper Surface Closeoff 2 is the second pass closeoff for upper 
surfaces of the support material. It is used to form a solid surface over the open 



70 

Support Fill grid on the layer before build material is built on top of the support 
region.  

Settings 

The Settings menu contains various options for modifying the 3ZAnalyzer 
display.  See Figure 44: File Settings Dialog Box.  

Units 

The units used for displaying numeric values are set in the Settings menu. Select 
either Inches or Millimeters. When the display units are set to Inches, the Z 
value for the current slice is displayed in inches, and the coordinate position of 
the cursor is displayed in mils (1/1000 inch). When the display units are set to 
Millimeters, both the Z value and the position of the cursor are displayed in 
millimeters. 

Machine Type 

The machine type setting is used to calculate accurate time estimates for each 
particular type of machine.  

 

 

 

 

 

 

 

 

 

 

 

           Figure 44: File Settings Dialog Box 
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File Settings 

File Settings displays information from the binary file. This includes the 
generating program, the machine type, the model extents and the number of 
slices. If multiple copies or model offsets were set, these are also shown. 
Configuration data for all slice ranges is included. The File Settings dialog is 
shown in                           Figure 45: Options Dialog  Box. 

 

Options 

Click on Options to display the Options dialog, as shown in Figure 45: Options 
Dialog Box.  

 

 

 

 

\ 

 

 

                          Figure 45: Options Dialog Box 

Use the slider to select the amount of time to pause after displaying each slice. 
This time varies between zero and two seconds, in increments of 1/10 second. 
The default is to play slices as quickly as possible, with zero pause. 

The Default Directory sets the default location to use when loading build files. 
Click the Default Directory button and select the directory to use.  

View Options 

The view options, located in the View menu, are provided to give additional 
information about the file and the individual layers. 

Vector Sequence Numbers toggles the display of vector sequence numbers 
on and off. This is used to locate vector endpoints and to determine the order in 
which vectors are laid down.
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Using 3ZOrganizer 

Overview 

3ZOrganizer is a program that retrieves, and process STL or SLC files 
automatically. Files can be dragged, copied or exported to an input folder.  
3ZOrganizer will then automatically load, auto arrange, and process the files to 
create a printer  file for any of the 3Z family of printers. 3ZOrganizer works in 
conjunction with 3ZWorks, 3ZAnalyzer and the 3Z printer driver. The program is 
launched, settings are established, and then the program is minimized and 
resides hidden from view. When a file or folder of multiple files is sensed in the 
input queue, the program will execute and process the files.  

Starting the program 

3ZOrganizer is automatically installed as part of the 3ZWorks installation 
process.  To start the program, locate the file 3ZOrganizer.exe. It is located in 
the same folder that 3ZWorks was installed. 

 To start the program, open the file 3ZOrganizer.exe. 

 

The opening screen is shown in Figure 46: Opening screen and program 
folders  

 

 

 

 

 

 

 

 

Figure 46: Opening screen and program folders 
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Folder Functions 

The folders used by 3ZOrganizer are shown Figure 46: Opening screen and 
program folders.   The folders function as follows: 

 

• 3ZQueue. This folder is the origin point for all files to be processed. The 
STL or SLC file(s) are dragged, dropped, or exported here. Depending on 
the refresh time settings, the folder will be accessed and reviewed by 
3ZOrganizer.  Any new files will be retrieved and processed.  

• Processed. This folder contains all files retrieved from the 3ZQueue folder 
and processed through 3ZWorks. It will contain the original files and files 
ready for the printer. 

• Untransferred Models. This folder contains a processed file ready for the 
printer. The files are held in this folder until the currently busy printer is 
finished printing. Each printer serial number available will have its own 
unique separate sub folder. 

Settings 

3ZOrganizer settings determine how files are processed, how often the program 
looks for a new input file and also indicates where program information is located 

The top section of the settings dialog box displays where the various program 
files are located and allows the user to validate these locations. If checked, 
3ZOrganizer will display the Data and or Models directories. See Figure 47: 
Directory settings. 

 

•  The 3ZOrganizer directory  is the location where files should be dropped 
or copied into. This is the folder that 3ZOrganizer will look to for new files.  

•  Show  Data Directory  , if checked, will display the location of all the 
folders associated with 3ZWorks and 3ZOrganizer in the opening screen. 

• Show  Model Directory will display the location of the folder where model 
files will be loaded from as specified in                                                                                                                                                      
Settings>Options > Default Model Directory 3ZWorks. 

• Validate 3ZWorks  Will display the location of 3ZWorks and launch the 
program. 

• Configure 3ZWorks will launch 3ZWorks and display the printer driver 
detailed settings. See page 62 for more information. 

• Validate 3ZAnalyzer Will display the file location and launch 3ZAnalyer. 
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Figure 47: Directory settings 

The bottom section of the settings dialog box, displays the processing mode and 
refresh time. See Figure 48: Processing and Refresh times.   The processing 
mode determines how 3ZWorks will process a file when it is retrieved from the 
3ZOrganizer job queue folder. The processing modes are as follows: 

• 3ZWorks  The file(s) will be loaded into 3ZWorks and 3ZWorks will be 
opened for full user control. 

• Printer Interface The file(s) will be loaded into 3ZWorks and the printer 
driver will be initiated and displayed. 

• Wizard The file(s) will be loaded into 3ZWorks and the 3ZWizard will guide 
the user through the file preparation process. 

• Full Auto The file(s) will be loaded, processed with the last configuration 
used, and sent directly to last destination used. This process will run 
totally in the background with no visual or user interaction occurring. 

•  IMPORTANT !   Models must be oriented properly within the design 
software prior to using the Full Auto  setting. The models will be auto 
arranged on the XY axis only and processed as received. 
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                     Figure 48: Processing and Refresh times 

The refresh time is the interval in seconds that 3ZOrganizer will look at the job 
queue folder and retrieve files for processing. 

Menu Bar 

Figure 49: Menu Bar 

Figure 49: Menu Bar shows the 3ZOrganizer menu bar. The functions are as 
follows: 

Process 

3ZOrganizer will immediately process all files in the job queue folder. 

Empty 

Allows the user to empty the contents of the Job queue, processed, and 
untransferred models folders. 
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View 

Enable the viewing of the Toolbar, Status Bar, and current printer status.  
Refresh all views. 

Settings 

See Settings section 

Menu bar Icons 

The menu bar icons are described in Figure 50: Menu bar Icons 

 

 

Figure 50: Menu bar Icons 
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CAD Guidelines 

This section provides basic guidelines for transferring CAD files to 3ZWorks 
using STL and other file formats. Recommendations for specific CAD programs 
are also included.  

Geometric Requirements 

Before creating a facet file or a slice file, make sure your CAD model meets the 
following conditions: 

• Surfaces must completely enclose a volume, forming a watertight solid with 
no gaps between surfaces 

• Surfaces must be trimmed to their intersection boundaries.  Separate pieces 
must be booleaned together if they are intended to be one piece. 

• Surfaces must have their outer unit normals pointing away from the solid 
material  

• Solid models must form a valid solid  

• Multiple models must not touch or intersect 

• Features on the model should be no smaller than 0.010 inches (.254mm) with 
an aspect ratio less than three. 

Do not generate support structures manually since this is done automatically by 
3ZWorks. For slice files, do not use any tool width compensation since this is 
also calculated automatically by 3ZWorks.  

STL Tolerances 

The facet and slice files used for building models are approximations to the 
original CAD model. Most CAD products have tolerance settings used for 
generating STL and other files. Matching the file tolerances to the tolerances of 
the Solidscape machine is an important step in building accurate parts. If 
tolerances are set too large, the facets will be visible on the final model and the 
part will look coarse, and could be inaccurate. If the tolerances are too small, 
however, far too many facets can be generated producing a very large file and 
slowing down 3ZWorks slicing and filling operations. Facets that are smaller than 
the individual droplets of build material produced by the machine’s jets are 
obviously below the tolerance of the machine. 
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Typically, CAD products have a setting for STL chord height tolerance or mesh 
tolerance. This is the maximum perpendicular distance between a facet and the 
model surface, which is also the maximum error between the facet file and the 
CAD model. The recommended setting for Solidscape machines is 0.0005 
inches (.0125 mm) but no less than 0.0001 inches (.0025 mm). A chord height 
tolerance greater than about 0.005 inches (.125 mm) will produce visible facets, 
and will not decrease build times significantly. 

Some CAD products also have a setting for an angle tolerance, which is used to 
specify the shallowest angle between facets. The recommended setting is either 
175 degrees or 5 degrees, depending on the how the angle is measured. 

Some CAD products only provide a relative tolerance, such as a range of 
settings from “fine” to “coarse”. Determining the optimum setting in these cases 
is not as direct, and can take some experience. When a facet file is displayed in 
3ZWorks using a shaded view, the individual facets are displayed much as they 
will appear on the finished part. If these look too coarse, regenerate the file using 
a finer setting. To determine if the setting is too fine, slice the STL file using the 
configuration you intend to use and with the Eliminate All Support option 
selected. (Eliminating the support speeds up the slicing and filling times.) Then 
look at the build perimeter vectors in the build file using 3ZAnalyzer. Turn on 
Vector Sequence Numbers in the View menu. If there are too many vectors 
along a curve, or if there are many very short vectors (less than 0.002 inches 
(.0125 mm)) a coarser tolerance setting should be used for generating the STL 
file. 
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CAD Products 

3ZWorks supports several file formats for transferring 3D CAD models to the 3Z 
Printer. These formats are STL, AutoCAD DXF, and Alias/Wavefront OBJ. 
Supported slice formats are SLC, modified HPGL, and 3ZWorks slice format. 
Virtually every 3D CAD package is able to produce at least one of these file 
formats. When a CAD package provides a choice of facet file formats, binary 
STL format files are preferred because they are much more compact than ASCII 
STL or DXF format files. 

Specific guidelines for each CAD system are discussed in the following 
subsections. 

SolidWorks 

In general, SolidWorks provides excellent STL files. When generating STL files 
from assemblies, do not save all parts to a single file unless a non-zero 
clearance has been specified between all components of the assembly. In 
SolidWorks 99 or later versions, use the Check for Interferences option under 
STL Export Options to check for this condition.  

JewelCad 

Although JewelCad will produce STL files, they are not recommended for input to 
3ZWorks. Instead, use SLC slice files to transfer jewelry models to 3ZWorks. 
Choose a slice thickness that matches one of the available slice thicknesses in 
the 3ZWorks configurations, especially when using metric. In addition, be sure to 
orient the part relative to the build platform before generating the SLC file, since 
slice files cannot be rotated in 3ZWorks. If the part needs to be scaled to 
compensate for shrinkage in the casting process, it must be scaled in JewelCad 
before generating the SLC file. 

Pro-Engineer 

In general, Pro-Engineer provides excellent STL files. Observe the geometric 
requirements listed above. 

IDEAS 

In general, IDEAS produces excellent STL files. Observe the geometric 
requirements listed above. 
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Intergraph I/Design and EMS 

These two products provide excellent STL files. In I/Design, be sure that 
individual surfaces are trimmed to their intersecting boundaries. Also ensure that 
the surfaces match at their common boundaries to within 0.0001 inch.  

In EMS, be sure individual models are Boolean Unioned together. This operation 
trims intersecting surfaces and removes redundant surfaces from inside the 
model. Any overlapping solid must be unioned. Solids that are disjoint (separated 
in space) do not have to be unioned. Observe the geometric requirements listed 
above. 

Unigraphics 

STL files are produced from Unigraphics if the model was built with solids. To 
ensure redundant faces are not surfaced, the model must not contain multiple 
solids that share the same faces or interfere with each other. If multiple solids 
are used to construct a model, ensure they are merged into one solid entity. Use 
the solid to surface function to create a set of surface entities that accurately 
define the boundary of the model. Use these surfaces in the STL module to 
create a clean STL file. 

CATIA 

The STL translator provided by CENIT-GMBH produces excellent STL files from 
CATIA formatted files. Observe the geometric requirements listed above. 

AutoCAD 

AutoCAD files are imported into 3ZWorks using the STL and DXF file format. 
Both surface and solid models can be imported. The following table gives a quick 
guideline for exporting models from AutoDesk products. 
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AutoDesk Product Export Method 

AutoCAD r13 and above File Export STL 

AutoCAD r12, r11, r10 Explode polyface meshes to 3D Face 
elements and export using DXFOUT 

Designer DXF, see procedure below 

AME STL, see procedure below 

AutoSurf DXF, see procedure below 

Most rapid prototype machines require that surfaces be positioned such that the 
normal vector to the surface points outward, away from solid material. This is 
also true for rendering surfaces in AutoCAD. The rule is if the surfaces are 
properly rendered with back faces removed in AutoCAD, then the surfaces will 
be oriented correctly in 3ZWorks. 

The model will not shade correctly if the outer unit normals are incorrect. In some 
cases, the facet normals can be repaired in 3ZWorks, but it is always preferable 
to fix them in AutoCAD before the model is exported. 

3ZWorks can import AutoCAD DXF files provided they are prepared according to 
the guidelines given below. It is recommended that model files be saved as STL 
binary files since DXF files occupy large amounts of disk space by comparison.  

Preparing DXF Models in AutoCAD 

Convert AutoCAD files to 3DFACE elements before exporting them to a DXF file. 
The specific steps needed to do this vary depending on the AutoCAD modules 
used to produce the 3D models. The following are the most common model 
types with specific steps for 3DFACE and DXF conversion: 

• Designer − Use the ADMESH command to turn the mesh on and specify the
mesh tolerance. When the model is meshed, save the model in a new
temporary drawing file. Explode the copied mesh twice to reduce it to
3DFACE elements and DXFOUT the result. Discard the temporary drawing
file because it has been permanently altered by the explode command. In
some cases, arrowheads from dimensions are erroneously exported. If this
occurs, a work-around in AutoCAD-R12 is to move the mesh away from the
area where it was created, then DXFOUT entities only. Select only the mesh
using a window or fence.

• AME − Set the SOLWDENS variable to reflect the density of the desired
mesh. Use the SOLMESH command to mesh the model. When the model is
meshed, save the model in a new temporary drawing file. Explode the mesh
twice to reduce it to 3DFACE elements and DXFOUT the result. Discard the
temporary drawing file because it has been permanently altered by the
explode command.

Note: 
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Use SOLSTLOUT to produce the STL file directly from AME. 

• AutoSurf − Prepare the model by making sure all surface normals are correct
and that the surfaces define a closed volume. In Surface Display, select
Polyface Mesh and Unhide. Also check the Display Tolerance box and insert
a value small enough to give a smooth mesh. To break the AutoSurf model
down into 3DFACE elements, use the IGES translator supplied with AutoSurf.
This is not the standard IGES translator that is supplied with AutoCAD-R12.

The procedure is to export the model as an IGES file, and then read it back in 
again. This breaks the individual surface meshes out of their AutoSurf format. 
Use the following steps: 

− Click on Edit Options in the IGES translator dialog

− Click on IDP Mappings

− Check the Polyface mesh option on

− Start a new AutoCAD drawing and use the IGES translator to re-
enter the IGES model. This time, on the IGES dialog, make sure
the Use AutoSurf Mappings item is not checked. Re-read the mesh
into the AutoCAD drawing and use the copy command to make a
copy of the mesh. Explode this mesh and then DXFOUT the model.

Alias / Wavefront 

In general, Alias provides acceptable STL files and also provides OBJ and DXF 
files. The recommended file format is STL. Observe the geometric requirements 
listed above. 

3DStudio and Simply3D 

These products are capable of exporting 3DFACE elements directly in DXF files. 
Be sure to verify that the models render correctly with back-face rendering turned 
off. This will ensure that unit normals are oriented correctly. 

CADKEY and Picture-It 

Excellent STL files can be generated in Picture-It and in CADKEY designs of 
solid models. Observe the geometric requirements listed above. In general, if the 
STL file displays correctly in Picture-It, the STL file will work in 3ZWorks. 
CADKEY's Advanced Modeler program is not recommended for use as an STL 
file generator for the PatternMaster or ModelMaker. 



File Formats 

This section provides a brief 
description of the file formats that 
can be used for building models with 
3ZWorks. 

STL Binary and 

ASCII 

3ZWorks uses the format specified 
in the Stereolithography Interface 
Specifications (STL) from 3D 
Systems, Inc. part number 50065-
S01-00, October, 1989/December 
16, 1991 

DXF File 

3ZWorks uses the standard 
AutoCAD DXF (drawing interchange 
file) format. Only 3DFACE elements 
are read from the file. All other 
geometry is ignored.  




